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RZ/T1 Group
Initial Settings of the Microcomputers Incorporating the R-IN Engine

APPLICATION NOTE

Outline
This application note describes a sample program for making initial settings of the RZ/T1 microcomputers incorporating 
the R-IN Engine.

The features of this program are as follows:
• The Cortex-R4 core makes initial settings after it is released from the reset state and releases the Cortex-M3 from 

reset. The R4 core then generates an inter-CPU interrupt, and makes LED 0 flash with a predetermined period.
• The Cortex-M3 core makes initial settings after it is released from the reset state and waits for the inter-CPU 

interrupt request from the Cortex-R4. On reception of the interrupt, the M3 core lights up LED 1.
• Pressing the switch SW2 makes the Cortex-R4 write “LED data” including the state of LED 0 (on or off) to the 

shared memory area. For its own part, the M3 core constantly reads the LED data in the shared memory and reflects 
the state read from there in LED 1.

Target Devices
RZ/T1 group

When applying the sample program covered in this application note to another microcomputer, modify the program 
according to the specifications for the target microcomputer and conduct an extensive evaluation and testing of the 
modified program.
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1. Specifications
Table 1.1 lists the peripheral modules to be used and their applications and Figure 1.1 shows the operating 
environment. 

Table 1.1 Peripheral Modules and Applications

Peripheral Module Application

Clock generator (CPG) Supplying the CPU clock and low-speed on-chip oscillator clock

Interrupt controller (ICUA) Handling interrupts through an external interrupt input pin (IRQ5) and inter-CPU 
interrupts

Extended internal RAM The shared memory area (extended internal instruction RAM, “RAM I”) and mem-
ory area for the program of the Cortex-M3 (extended internal data RAM, “RAM D”)

Error control module (ECM) Initializing the ERROROUT# pin

General-purpose input/output ports Pins which control switching the LEDs on and off

Note 1. Indicates the device that the user needs to prepare.

Figure 1.1 Operating Environment
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2. Operating Environment
The sample program described in this application note is for the environment below.

Table 2.1 Operating Environment

Item Description

Microcomputer RZ/T1 group

Operating frequency CPUCLK (Cortex-R4): 450 MHz
ICLK (Cortex-M3): 150 MHz

Operating voltage 3.3 V

Integrated development environment Embedded Workbench® for Arm, version 8.20.2 from IAR Systems
DS-5TM 5.26.2 from Arm
e2 studio 6.1.0 from Renesas

Operating mode SPI boot mode
16-bit-bus boot mode

Board RZ/T1 Evaluation Board (RTK7910022C00000BR)

Devices
(functions to be used on the board)

• NOR flash memory (connected to CS0 and CS1 spaces)
Manufacturer: Macronix International Co., Ltd.
Model: MX29GL512FLT2I-10Q

• SDRAM (connected to CS2 and CS3 spaces)
Manufacturer: Integrated Silicon Solution Inc.
Model: IS42S16320D-7TL

• Serial flash memory
Manufacturer: Macronix International Co., Ltd.
Model: MX25L51245G
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3. Related Application Notes
The application note related to this document is listed below for reference. 

• RZ/T1 Group Application Note: Initial Settings
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4. Peripheral Modules
The basics of the clock generator (CPG), the interrupt controller (ICUA), the error control module (ECM), extended 
internal RAM, and general-purpose input/output ports are described in the “RZ/T1 Group User's Manual: Hardware.”
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5. Hardware

5.1 Hardware Structure Example
Figure 5.1 shows an example of hardware structure.

5.2 Pins Used
Table 5.1 lists the pins to be used and their functions.

Figure 5.1 Example of Hardware Structure

Table 5.1 Pins and Functions

Pin Name Input/Output Description

MD0 Input Select the operating mode 
MD0 = L and MD1 = L and MD2 = L (SPI boot mode)
MD0 = L and MD1 = H and MD2 = L (16-bit-bus boot mode)MD1 Input

MD2 Input

IRQ5 Input SW2 (IRQ pin interrupt)

PF7 Output Switches LED 0 on and off.

P56 Output Switches LED 1 on and off.

Extended internal RAM I/O port

ICUA
(Interrupt Control Unit A) Cortex-R4 Power consumption 

reducer

Register-writing protection 
functionCortex-M3

RZ/T1
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6. Software
This section explains the case of EWARM (from IAR systems) unless otherwise stated.

6.1 Operation Overview
The sample program described in this application note makes initial settings of the Cortex-R4 and Cortex-M3 cores. 
1. The program for the Cortex-R4 core makes initial settings after power for the core is switched on. This core copies 

the program code for the Cortex-M3 from the external flash memory into the extended internal RAM, and releases 
the M3 core from the reset state. Note that the R4 core does not copy the code for the M3 core if the program is to be 
executed directly from the RAM. After making settings for the LED-controlling port pins and interrupts, the R4 
core generates an inter-CPU interrupt to notify the M3 core of completion of the initial settings.

2. The program for the Cortex-M3 core makes initial settings after it is released from the reset state (software reset 2) 
and waits for an inter-CPU interrupt from the Cortex-R4 core. 

3. The Cortex-R4 core makes LED 0 flash on and off with a predetermined period. The state of LED 0 (switched on or 
off) is written to the shared memory area (extended internal RAM) on detection of the switch SW2 being pressed. 
On its side, the Cortex-M3 core constantly reads LED data from the shared memory and turns LED 1 on or off 
according to the value read (the initial value is “on”). For example, if SW2 is pressed while LED 0 is off, the state of 
LED 0 is reflected in LED 1, resulting in LED 1 being switched off.

Figure 6.1 shows the  processing for initial settings of the microcomputers incorporating the R-IN engine in outline.

Figure 6.1 Overview of Processing for Initial Settings of the Microcomputers incorporating the R-IN Engine
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6.1.1 Preparation
Make appropriate setting for SW4 on the RZ/T1 Evaluation Board (RTK7910022C00000BR) depending on the project 
to be used. Table 6.1 shows the settings of SW4. Detailed settings of SW4 are described in the “RZ/T1 Evaluation Board 
RTK7910022C00000BR User's Manual” (see Section 8, Related Documents).

6.2 Memory Map
The address space of the RZ/T1 group and the memory map of the RZ/T1 Evaluation Board are described in the “RZ/T1 
Group Application Note: Initial Settings” and the “RZ/T1 Group User's Manual: Hardware.” 

6.2.1 Section Assignment for the Sample Program
Table 6.2 lists the sections to be used in this sample program. Figure 6.2 shows the assignment of sections (for the 
Cortex-R4 in the 16-bit-bus boot version) as an example.

The details of the sections for the Cortex-R4 are described in the “RZ/T1 Group Application Note: Initial Settings”.

Note 1. The RAM execution version does not have this area.
Note 2. This is assigned to the NOR flash memory in the case of the 16-bit-bus boot mode version and to the serial flash memory in 

the case of the SPI boot mode version. 
Note 3. The RAM execution version does not have this area. Instead of this area, according to the section assignment of the Cortex-

M3, the development tool directly downloads the program to the area in extended internal RAM I from which it will be 
executed.

Table 6.1 Settings of SW4

Sample Program SW4-1 SW4-2 SW4-3 SW4-4 SW4-5 SW4-6

16-bit-bus boot mode version ON OFF ON ON ON OFF

SPI boot mode version ON ON ON ON ON OFF

RAM exectuion version Either of the above combinations.

Table 6.2 Sections to be Used (Cortex-R4)

Area Name Description Type
Loading 
Area

Execution 
Area

VECTOR_WBLOCK Reset and exception processing vector table Code — ATCM

USER_PRG_WBLOCK User application program area (for execution) Code — ATCM

USER_DATA_WBLOCK User application program variable area (for execution) Data — ATCM

CSTACK Stack area Data — ATCM

SVC_STACK Supervisor (SVC) mode stack area Data — ATCM

IRQ_STACK IRQ mode stack area Data — ATCM

FIQ_STACK FIQ mode stack area Data — ATCM

UND_STACK Undefined (UND) mode stack area Data — ATCM

ABT_STACK Abort (ABT) mode stack area Data — ATCM

LDR_DATA_WBLOCK Loader program variable area (for execution) Data — BTCM

LDR_PRG_WBLOCK Loader program area (for execution) Code — BTCM

ldr_param Loader parameters*1 Data FLASH*2 —

LDR_PRG_RBLOCK Loader program area (for storing)*1 Code FLASH*2 —

LDR_DATA_RBLOCK Loader program variable area (for storing)*1 Data FLASH*2 —

VECTOR_RBLOCK Reset and exception processing vector table area (for storing)*1 Code FLASH*2 —

USER_PRG_RBLOCK User application program area (for storing)*1

User application program area for the Cortex-M3 (for storing)*3
Code FLASH*2 —

USER_DATA_RBLOCK User application program variable area (for storing)*1 Data FLASH*2 —
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Table 6.3 Sections to be Used (Cortex-M3)

Area Name Description Type Loading Area Execution Area

vectors Vector area Code Extended internal RAM I Extended internal RAM I

readonly User application program area Code Extended internal RAM I Extended internal RAM I

_SHARED_MEM Shared memory area Data Extended internal RAM D Extended internal RAM D

readwrite User application program variable area Data Extended internal RAM D Extended internal RAM D

HEAP Heap area Data Extended internal RAM D Extended internal RAM D

CSTACK Stack area Data Extended internal RAM D Extended internal RAM D
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Note 1. This corresponds to the serial flash (SPIBSC area) in case of SPI boot version. Read addresses as if the start 
address is 1000 0000h.

Note 2. The loader parameters (ldr_param section) are used in boot processing. Refer to the “RZ/T1 Group User's 
Manual: Hardware for details. 

Figure 6.2 Assignment of Sections (for the Cortex-R4 in the 16-Bit-Bus Boot Version)
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6.2.2 MPU Settings
MPU settings are described in the “RZ/T1 Group Application Note: Initial Settings.” 

6.2.3 Exception Processing Vector Table
Exception processing vector table is found in the “RZ/T1 Group Application Note: Initial Settings.”

Note: The sections in extended internal RAM I are copied by the Cortex-R4 as the CM3_SECTION.

Figure 6.3 Assignment of Sections (Cortex-M3)
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6.3 Interrupts
Table 6.4 lists the interrupts used in the sample program. 

6.4 Fixed-Width Integer Types
Table 6.5 lists the fixed-width integers for sample program.

Table 6.4 Interrupts Used in Sample Program

Interrupt (Source ID) Priority Process in Outline

Inter-CPU interrupt (IRQ1) 15 The Cortex-R4 notifies the Cortex-M3 of the completion of initial settings (applicable to the 
Cortex-R4 and Cortex-M3).

IRQ pin interrupt 5 (IRQ9) 15 State of lighting of LED 0 (switched on or off) is written to the shared memory on detection 
of SW2 being pressed (applicable to the Cortex-R4). 

Table 6.5 Fixed-Width Integers for Sample Program

Symbol Description

int8_t 8-bit signed integer (defined in the standard library)

int16_t 16-bit signed integer (defined in the standard library)

int32_t 32-bit signed integer (defined in the standard library)

int64_t 64-bit signed integer (defined in the standard library)

uint8_t 8-bit unsigned integer (defined in the standard library)

uint16_t 16-bit unsigned integer (defined in the standard library)

uint32_t 32-bit unsigned integer (defined in the standard library)

uint64_t 64-bit unsigned integer (defined in the standard library)
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6.5 Constants/Error Codes
Table 6.6 lists the constants used in the sample program. Detail on the program of the Cortex-R4 core is found in the 
“RZ/T1 Group Application Note: Initial Settings.”

6.6 Structures/Unions/Enumerated Types
Figure 6.4 is the structures, unions, and enumerated types used in the sample program. Detail on the program of the 
Cortex-R4 core is described in the “RZ/T1 Group Application Note: Initial Settings.”

Table 6.6 Constants Used in the Sample Program

Constant Name Value Description

LED_OUTPUT_HIGH (1) Output value indicating the lighting state of the LED

SHM_SUCCESS (0) “Successful” control flag for the shared memory driver 

SHM_ERR (-1) “Unsuccessful” control flag for the shared memory driver

SHM_SEMFNO_TOTAL (8) Total number of the semaphore flags for the shared memory driver

SHM_ SEMFNO_0 (0) Semaphore flag 0 for the shared memory driver

SHM_ SEMFNO_1 (1) Semaphore flag 1 for the shared memory driver

SHM_ SEMFNO_2 (2) Semaphore flag 2 for the shared memory driver

SHM_ SEMFNO_3 (3) Semaphore flag 3 for the shared memory driver

SHM_ SEMFNO_4 (4) Semaphore flag 4 for the shared memory driver

SHM_ SEMFNO_5 (5) Semaphore flag 5 for the shared memory driver

SHM_ SEMFNO_6 (6) Semaphore flag 6 for the shared memory driver

SHM_ SEMFNO_7 (7) Semaphore flag 7 for the shared memory driver

/* Shared memory struct */
/* Size MAX 4KB */
struct st_shm
{
    uint32_t LED_DATA;
};

/* struct of [SYSTEM.SYTSEMFn] register */
typedef struct
{
          union
           {
                           unsigned long LONG;
                           struct
                            {
                                          unsigned long SEMF:1;
                                          unsigned long :31;
                             } BIT;
           } SYTSEMF;
} st_sytsemf;

Figure 6.4 Structures/Unions/Enumerated Types Used in Sample Program
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6.7 Global Variables
Table 6.7 lists the global variables. Detail on the program of the Cortex-R4 core is described in the “RZ/T1 Group 
Application Note: Initial Settings.”

6.8 Functions
Table 6.8 lists the functions. Detail on the program of the Cortex-R4 core is described in the “RZ/T1 Group Application 
Note: Initial Settings.”

Note:  The functions are common among cores unless otherwise specified.

Table 6.7 Global Variables

Type Variable Name Description Function

uint8_t g_ready_flag Initialization completion flag of the Cortex-R4 init_main.c (Cortex-M3)

uint32_t g_led_data Variable to indicate the state of the LED main.c (Cortex-R4)
init_main.c (Cortex-M3)

Table 6.8 Functions

Function Name Page

R_SHM_Init 17

R_SHM_memcpy 17

R_SHM_Load_uint32 17

R_SHM_Load_int32 18

R_SHM_Load_uint16 18

R_SHM_Load_int16 18

R_SHM_Load_uint8 18

R_SHM_Load_int8 19

main (Cortex-R4) 19

init_cm3 (Cortex-R4) 19

R_IRQ9_isr (Cortex-R4) 20

main (Cortex-M3) 19

IRQ_INTERCPU_IRQHandler(Cortex-M3) 20
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6.9 Specification of Functions
Specifications of the functions used in the sample program are as follows.

6.9.1 R_SHM_Init

6.9.2 R_SHM_memcpy

6.9.3 R_SHM_Load_uint32

R_SHM_Init

Synopsis Initializing the shared-memory driver

Declaration int32_t R_SHM_Init (uint32_t semfno)

Description This function makes initial settings of the specified semaphore register to be used for the shared 
memory driver.

Arguments uint32_t semfno Specifies the number of the semaphore register to be initialized as a value 
from 0 to 7.

Return value SHM_SUCCESS: succeeded.
SHM_ERR: failed.

Remarks None

R_SHM_memcpy

Synopsis Copies data to and from the shared memory area 

Declaration int32_t R_SHM_memcpy(void *dst, void *src, size_t size)

Description This function copies multiple bytes of data to and from the shared memory area.

Arguments void *dst Pointer to the address of the destination memory area

void *src Pointer to the address of the source memory area

size_t size Size of memory to be transferred.

Return value SHM_SUCCESS: succeeded
SHM_ERR: failed

Remarks None

R_SHM_Load_uint32

Synopsis Function for loading four bytes of unsigned int type data to and from the shared memory

Declaration int32_t R_SHM_Load_uint32(uint32_t *dst, uint32_t *src)

Description This function loads four bytes of unsigned int type data to and from the shared memory. 

Arguments uint32_t *dst Pointer to the address of the destination memory area

uint32_t *src Pointer to the address of the source memory area 

Return value None

Remarks None
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6.9.4 R_SHM_Load_int32

6.9.5 R_SHM_Load_uint16

6.9.6 R_SHM_Load_int16

6.9.7 R_SHM_Load_uint8

R_SHM_Load_int32

Synopsis Function for loading four bytes of signed int type data to and from the shared memory

Declaration int32_t R_SHM_Load_int32(int32_t *dst, int32_t *src)

Description This function loads four bytes of singed int type data to and from the shared memory. 

Arguments int32_t *dst Pointer to the address of the destination memory area

int32_t *src Pointer to the address of the source memory area 

Return value None

Remarks None

R_SHM_Load_uint16

Synopsis Function for loading two bytes of unsigned int type data to and from the shared memory area

Declaration int32_t R_SHM_Load_uint16(uint16_t *dst, uint16_t *src)

Description This function loads two bytes of unsigned int type data to and from the shared memory area. 

Arguments uint16_t *dst Pointer to the address of the destination memory area

uint16_t *src Pointer to the address of the source memory area 

Return value None

Remarks None

R_SHM_Load_int16

Synopsis Function for loading two bytes of signed int type data to and from the shared memory area

Declaration int32_t R_SHM_Load_int16(int16_t *dst, int16_t *src)

Description This function loads two bytes of signed int type data to and from the shared memory area. 

Arguments int16_t *dst Pointer to the address of the destination memory area

int16_t *src Pointer to the address of the source memory area 

Return value None

Remarks None

R_SHM_Load_uint8

Synopsis Function for loading one byte of unsigned int type data to and from the shared memory area

Declaration int32_t R_SHM_Load_uint8(uint8_t *dst, uint8_t *src)

Description This function loads one byte of unsigned int type data to and from the shared memory area. 

Arguments uint8_t *dst Pointer to the address of the destination memory area

uint8_t *src Pointer to the address of the source memory area 

Return value None

Remarks None
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6.9.8 R_SHM_Load_int8

6.9.9  main (Cortex-R4)

6.9.10 init_cm3 (Cortex-R4)

6.9.11 main (Cortex-M3)

R_SHM_Load_int8

Synopsis Function for loading one byte of signed int type data to and from the shared memory area

Declaration int32_t R_SHM_Load_int8(int8_t *dst, int8_t *src)

Description This function loads one byte of signed int type data to and from the shared memory area. 

Arguments int8_t *dst Pointer to the address of the destination memory area

int8_t *src Pointer to the address of the source memory area 

Return value None

Remarks None

main

Synopsis Main processing 

Declaration int main (void)

Description This is the user application program for the Cortex-R4 core. 

Arguments None

Return value None

Remarks None

init_cm3

Synopsis Initialization processing of the Cortex-M3 core

Declaration void init_cm3(void)

Description This function copies the program code for the Cortex-M3 from an external flash memory to the 
extended internal RAM and releases the M3 from the reset state. 

Arguments None

Return value None

Remarks When the program is run directly from RAM, it does not have to be copied, so only releasing the 
Cortex-M3 from the reset state proceeds in this case. 

main

Synopsis Main processing

Declaration int main(void)

Description This is the user application program for the Cortex-M3 core. 

Arguments None

Return value None

Remarks None
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6.9.12 R_IRQ9_isr (Cortex-R4)

6.9.13 IRQ_INTERCPU_IRQHandler

R_IRQ_9_isr

Synopsis IRQ9 interrupt (IRQ pin interrupt 5) handling

Declaration void R_IRQ9_isr(void)

Description This function writes the state of lighting of LED 0 to the shared memory.

Arguments None

Return value None

Remarks None

IRQ_INTERCPU_IRQHandler

Synopsis Inter-CPU interrupt handling

Declaration void IRQ_INTERCPU_IRQHandler(void)

Description This function handles interrupt processing in response to interrupt requests from the Cortex-R4 
core and sets the g_ready_flag.

Arguments None

Return value None

Remarks None
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6.10 Flowchart

6.10.1 Initialization Processing of Shared Memory Driver 
Figure 6.5 shows the initialization processing of the shared memory driver.

Note 1. The steps within the broken lines are only included when running the program for the Cortex-R4.

Figure 6.5 Initialization Processing of Shared Memory Driver

R_SHM_Init

Returned value = 
SHM_SUCCESS

Designated semfno is out 
of the stipulated range?

Returned value = SHM_ERR

Yes

No

Redefine the semaphore 
register

SEMFREG ← Pointer to the SYTSEMFn register with the 
number stipulated in semfno.

Enable read-clear function.
Set the target resource to be 
available.

SYTSEMFEN.SEMFEN ← 1
SYTSEMFn.SEMFn ← 1

*1
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6.10.2 Processing to Copy Ranges of Memory to and from the Shared Memory Area
Figure 6.6 shows the processing to copy ranges of memory to and from the shared memory area.

Figure 6.6 Processing to Copy Ranges of Memory to and from the Shared Memory Area

R_SHM_memcpy

Returned value = 
SHM_SUCCESS

Yes

Set the target resource to 
be available SYTSEMFn.SEMFn ← 1

Target resource is 
available?

Processing to copy 
contents of memory

No
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6.10.3 Processing to Load a Value (4-Byte Unsigned Int Type) to and from the Shared 
Memory Area

Figure 6.7 shows the processing to load four bytes of unsigned int type data to and from the shared memory area.

6.10.4 Processing to Load a Value (4-Byte Signed Int Type) to and from the Shared 
Memory Area

For the flowchart of this processing, see Figure 6.7. Note that the value loaded in this processing is of the four-byte 
signed int type. 

6.10.5 Processing to Load a Value (2-Byte Unsigned Int Type) to and from the Shared 
Memory Area

For the flowchart of this processing, see Figure 6.7. Note that the value loaded in this processing is of the two-byte 
unsigned int type. 

Figure 6.7 Processing to Load a Value (4-Byte Unsigned Int Type) to and from the Shared Memory Area

R_SHM_Load_uint32

Returned value = 
SHM_SUCCESS

Yes

No

Set the target resource to 
be available

Target resource is 
available?

Four-byte unsigned int type 
data is loaded
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6.10.6 Processing to Load a Value (2-Byte Signed Int Type) to and from the Shared 
Memory Area

For the flowchart of this processing, see Figure 6.7. Note that the value loaded in this processing is of the two-byte 
signed int type. 

6.10.7 Processing to Load a Value (1-Byte Unsigned Int Type) to and from the Shared 
Memory Area

For the flowchart of this processing, see Figure 6.7. Note that the value loaded in this processing is of the one-byte 
unsigned int type.

6.10.8 Processing to Load a Value (1-Byte Signed Int Type) to and from the Shared 
Memory Area

For the flowchart of this processing, see Figure 6.7. Note that the value loaded in this processing is of the one-byte 
signed int type.
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6.10.9 Main Processing (Cortex-R4)
Figure 6.8 shows the flowchart of main processing of the Cortex-R4. 

Figure 6.8 Main Processing (Cortex-R4)

main
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memory driver
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indicates the state of  the LED (on or off), is loaded.
LED_DATA  LED_OUTPUT_DATA 

Port setting

ECM setting

Interrupt setting Settings of the inter-CPU interrupt (IRQ1) and the external pin interrupt (IRQ5)

Inter-CPU interrupt is 
generated

CPUINT.CM3INT  1

LED 0 flashes Toggle the output from PF7.

The semaphore register 0 is initialized.



R01AN2989EJ0131 Rev.1.31 Page 26 of 46
Jul. 13, 2018

RZ/T1 Group Initial Settings of the Microcomputers Incorporating the R-IN Engine

6.10.10 Initialization Processing of the Cortex-M3 Core
Figure 6.9 shows the flowchart of initialization processing of the Cortex-M3 core.

Note 1. This step is not included when the program is to be executed from the RAM.

Figure 6.9 Initialization Processing of Cortex-M3

init_cm3

Copying the program for the 
Cortex-M3

Program for the Cortex-M3 is copied from an external 
flash memory to the extended internal RAM I.*1

Release from software reset 2
Execute the software reset 2 to release the Cortex-M3 
from the reset state.
　SWRR2  0000 0000H

Return
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6.10.11 Main Processing (Cortex-M3)
Figure 6.10 shows the flowchart of main processing of the Cortex-M3. 

Figure 6.10 Main Processing (Cortex-M3)

main
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(on or off), is loaded from the shared memory.
g_led_data  ← ED_DATA 

High level is being output from P56 
(indicated by LED_DATA).

Control output from LED 1 
depending on the indicated 

state of the LED

Interrupt setting Setting of inter-CPU interrupt (IRQ1).

Initialization of the 
shared memory 

driver
The semaphore register 0 is initialized.

Value indicating the state 
of lighting of the LED is 
loaded from the shared 

memory

Yes

NoInter-CPU interrupt is 
generated?

(g_ready_flag = 1 ?)

Indication of the lighting state 
of LED 1 
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6.10.12 R_IRQ9 Interrupt (IRQ Pin Interrupt 5) Processing
Figure 6.11 shows the flowchart of R_IRQ9 interrupt (IRQ Pin interrupt 5) processing.

6.10.13 Inter-CPU Interrupt Processing
Figure 6.12 shows the flowchart of inter-CPU interrupt processing.

Figure 6.11 R_IRQ9 Interrupt (IRQ Pin Interrupt 5) Processing

Figure 6.12 Inter-CPU Interrupt Processing

R_IRQ9_isr
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7. Sample Program
Download the sample program from the Renesas Electronics website.
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8. Related Documents
• User's Manual: Hardware

RZ/T1 Group User's Manual: Hardware 
Download the latest version from the Renesas Electronics website. 

RZ/T1 Evaluation Board RTK7910022C00000BR User's Manual 
Download the latest version from the Renesas Electronics website.

• Technical Update/Technical News
Download the latest version from the Renesas Electronics website.

• User's Manual: Development Environment
The latest version for the IAR integrated development environment (IAR Embedded Workbench® for Arm) is 
available from the IAR Systems website.
The latest version for the Arm integrated development environment (Development Studio 5TM) is available from 
the Arm website.
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Appendix-1. Supplementary Notes on Development Environments
This section shows the settings required to perform debugging for the sample program for the Cortex-R4 core and the R-
IN engine (Cortex-M3 core) in each available development environment and the debugging procedures.

(EWARM from IAR systems)

<Steps up to debugging of the sample program (when booting is through the SPI)>

(1) Start up the EWARM environment. Go to [File] > [Open] > [Workspace] and then specify RZ_T1_init_cm3.eww. 
The project for the Cortex-M3 will start. 

(2) Select the [Rebuild All] item from the [Project] menu to rebuild the project. The binary file RZ_T1_init_cm3.bin is 
generated.

(3) Start up another EWARM environment. Go to [File] > [Open] > [Workspace] and then specify 
RZ_T1_init_serial.eww. The project for the Cortex-R4 will start. Rebuild the project in the same manner as in step 
(2).

(4) While the RZ/T1 evaluation board and I-jet are connected, click on the [Download and debug] button in the 
[Project] toolbar in the project for the Cortex-R4. Similarly, click on the [Attach to Running Target] button in the 
[Project] toolbar in the project for the Cortex-M3.

Note: Debugging of the project for the Cortex-M3 is not possible at this point because the core is in the reset state. Debugging of 
the project for the Cortex-R4 can proceed.

Overwri

DisassemblyDebug Log
Overwrite

Disassembly



R01AN2989EJ0131 Rev.1.31 Page 32 of 46
Jul. 13, 2018

RZ/T1 Group Initial Settings of the Microcomputers Incorporating the R-IN Engine

(5) Release the Cortex-M3 core from the reset state by the project for the Cortex-R4 by executing the process in its 
function init_cm3. The Cortex-M3 core is released from the reset state and debugging of the program for the 
Cortex-M3 core is then possible.

(6) This sample program uses inter-CPU interrupts from the Cortex-R4 core to the Cortex-M3 core. If you want to 
debug in the order of the actual operation, execute the project for the Cortex-M3 in advance through the interrupt 
settings and loading of data from the shared memory, and then execute the project for the Cortex-R4 to generate the 
inter-CPU interrupt. 

Debugging of the project for the 
Cortex-M3 becomes possible.

Proceed with the steps up 
to the “while” statement in 
advance.Inter-CPU interrupt is generated.
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(7) Debugging of the cores can then proceed without following given procedures.

<Project settings for the sample program>

Settings of EWARM related to the sample program for making initial settings of the microcomputers incorporating the 
R-IN engine are shown below. The details of the project for the Cortex-R4 core are given in the “RZ/T1 Group 
Application Note: Initial Settings.”

Note 1. The binary image for the Cortex-M3 is fetched into the section CM3_SECTION.
Note 2. This is required for EWARM V8.10.1 or later.

Details on the option settings are described in the C-SPY debugging guide C-SPY Macro from the IAR Systems and in 
related documents.

Table. Settings in the Project for the Sample Program (Cortex-R4)

Build Action

Build action set-
ting

Pre-build command line cmd /c "copy /Y "$PROJ_DIR$¥..¥..¥Cortex-
M3¥Device¥Renesas¥RIN_Engine¥Source¥Project¥Init¥IAR¥Debug¥
Exe¥RZ_T1_init_cm3.bin"
 "$PROJ_DIR$¥cm3.bin¥RZ_T1_init_cm3.bin""

Linker

Input*1 Keep symbols CM3_SECTION

Raw binary image File: $PROJ_DIR$¥cm3.bin¥RZ_T1_init_cm3.bin
Symbol: CM3_SECTION
Section: CM3_SECTION
Alignment: 4

Debugger

Extra options Use command line options Switch checkmarks on

Synchronous Asynchronous

--drv_default_breakpoint=1
--macro_param_etm_rute=2
--jet_emu_param=UseCTI=0*2

--drv_default_breakpoint=1
--macro_param_etm_rute=2
--jet_sigprobe_opt=shared

Multicore Symmetric multicore The number of cores: 1

Asymmetric multicore 
Enable multicore master mode 

Synchronous Asynchronous

Switch checkmarks on
Port: 53461
Slave work space:
$PROJ_DIR$\..\..\Cortex-M3\
Device\Rensas\RIN_Engine\
Project\Init\
IAR\RZ_T1_init_cm3.eww
Slave project: RZ_T1_init_cm3
Slave configuration: Debug
Attach the slave to running target:
Switch checkmarks on

Don't switch checkmarks on

Table. Settings in the Project for the Sample Program (Cortex-M3)

Output Converter

Output Generation of additional output file Switch checkmarks on:
  Output format: binary

Output file
Override default

Switch checkmarks on:
  $PROJ_DIR$¥RZ_T1_init_cm3.bin

Debugger

Extra options Use command line options Synchronous Asynchronous

--drv_default_breakpoint=1 --drv_default_breakpoint=1
--jet_sigprobe_opt=shared
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(DS-5 from Arm)

<Steps up to debugging of the sample program (when booting is through the SPI)>
(1) Create a folder to use as a workspace on your PC, where the sample program will be stored.
(2) Start up the DS-5 environment. Specify the folder in which you stored the sample programs in step 1 as the 

workspace. 
(3) Go to [File] > [Import]. On the [Import] window, select [Existing Projects into Workspace] in the [General] folder 

and click on the [Next] button.
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(4) Select the [Select archive file:] radio button and click on the [Browse..] button. Select the compressed program file 
“RZ_T1_R-IN_init_sflash.zip” on the list in the window and click on the [Finish] button.

(5) Select [Build All] from the [Project] menu. On completion of building, select [Run] from the [Project] menu and 
then select [Debug Configurations].

(6) While the RZ/T1 evaluation board and ULINK2 are connected, go to [DS-5 Debugger] and select [sflash] to show 
the window for configurations. Then, click on [Browse] and open the connection browser window as shown below. 
Select the target connection from the list in the window. Click on [Debug] in the debug configurations window and 
start debugging of the Cortex-R4.

Note: If you are using the sample program to be run from the RAM, skip the following step (7) to step (9), so only release the debug 
connection ram (Cortex-R4) from reset. 
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(7) When the PC is connected to the target, RZ_T_sflash_sample.ds, the script file for writing to serial flash memory, is 
automatically executed from the ¥RZ_T_sflash_sample¥script_sflash folder.

(1)

(2)

(3)
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(8) On completion of writing to the flash memory by the script, the message “Flash Programming Complete” appears in 
the application console window. 

(9) Apply a system reset. Set the hardware breakpoint immediately before the init_cm3 function, which is used to 
release the Cortex-M3 core from the reset state, and proceed with the steps up to the target process. To set a 
hardware breakpoint, right-click on the number for the row of the target process and select [DS-5 Breakpoint] from 
the menu, then select [Toggle Hardware Breakpoint].

(10) Go to [Run] > [Debug Configurations…] and open the widow of debug configurations. Select [DS-5 Debugger] and 
then [cm3_dual] and select the target for connection with ULINK2 in the same manner as in step (6), and make the 
debugging connection. At this point, reset vector catch is enabled on the Cortex-M3 by the script file 
“RZ_T_cm3.ds”.
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Note: Debugging of the project for the Cortex-M3 is not possible at this point because the core is in the reset state.

Note: The window shown above may pop up while connecting to the Cortex-M3. In this case, select [Run in Background].
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(11) Connect “sflash” (the Cortex-R4) as the target. When the Cortex-M3 is released from the reset state, debugging of 
“cm3_dual” connection (the Cortex-M3) can then start. The program stops at reset handler, which is set as the 
breakpoint in the previous step.

(12) Debugging of further cores can be done by following the same procedure as described from step (6) of the 
procedure for EWARM from IAR Systems. 

Note: Debugging of the Cortex-M3 alone is possible by using the debug connection “cm3_single”. Note that the target for connection 
with ULINK2 needs to be selected in the debugging configuration. 
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<Project settings for the sample program>

Setting of DS-5 related to the sample program for making the initial settings of the LSI chips incorporating the R-IN 
engine is shown below. 

Note 1. The binary image for the Cortex-M3 is fetched into the section CM3_SECTION.

Details on the option setting are described in the related documents from Arm.

(e2 studio from Renesas)

<Steps up to debugging of the sample program (when booting is through the SPI)>

(1) Create a folder to use as a workspace on your PC, where the sample program will be stored.
(2) Start up the e2 studio environment. Specify the folder in which you stored the sample programs in step 1 as the 

workspace. 
(3) Go to [File] > [Import]. On the [Import] window, select [Existing Projects into Workspace] in the [General] folder 

and click the [Next] button.

Table. Settings in the Project for the Sample Program (Cortex-R4)

Project -> Properties -> C/C++ Build -> Settings

Build Steps*1 Pre-build steps Command: fromelf --bin --output =../cm3.bin
../../RZ_T_cm3_sample/Debug/RZ_T_cm3_sample.axf

Post-build steps Command: after_build.bat ${ProjName} 
This command is not specified when the program is run directly from RAM.
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(4) Select the [Select archive file:] radio button and click on the [Browse..] button. Select the compressed program file 
“RZ_T1_R-IN_init_sflash.zip” and click on the [Finish] button.
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(5) Select [Build All] from the [Project] menu. On completion of building, select [Run] from the [Project] menu and 
then select [Debug Configurations]. 

(6) While the RZ/T1 evaluation board and J-Link are connected, go to [Renesas GDB Hardware Debugging] and select 
[sample_cr4 HardwareDebug] to show the window for configurations. Click on [Debug] in the debug 
configurations window and start debugging of the Cortex-R4.
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(7) After connecting to the target, resume the program by clicking on the [Resume] button, and proceed with the steps 
up to the process of writing the program for the Cortex-M3.

(1)

(2)
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(8) From [Run] on the menu bar, click on [Debug Configurations…] to open the debug configurations window, go to 
[Renesas GDB Hardware Debugging] and select [sample_cm3 HardwareDebug]. Click on [Debug] in the debug 
configurations window.
Since the program for the Cortex-M3 core has not yet been written, debugging the project for the Cortex-M3 is not 
possible at this point.

Note: On clicking the [Debug] button, a message window appears as below asking whether to disconnect the previous debugging 
session or not. Here, select [No] because this is for both the Cortex-R4 core and the R-IN engine (Cortex-M3 core). 

(9) On the [Debug] tabbed page, select “Thread #xxx” from the “Sample_cr4.x” folder. Then, from [Run] on the menu 
bar, click on [Step Over F6] to execute writing of the program for the Cortex-M3.

(10) Resume the program by clicking the [Resume] button while “Thread #xxx” from the “Sample_cm3.x” folder is 
selected. Debugging on the Cortex-M3 can then start. 

Note: The debugger releases the Cortex-M3 from the reset state on the debugging process, which is followed by releasing of the 
reset by the Cortex-R4, and there is no problem with these processes. When the debugger is not used, only the latter process 
proceeds.

(11) Debugging of further cores can be done by following the same procedure as described from step (6) of the 
procedure for EWARM from IAR Systems. 

Note: Debugging on the Cortex-R4 is possible by selecting the “Thread #xxx” in the “Sample_cr4.x” folder and on the Cortex-M3 by 
selecting the “Thread #xxx” in the “Sample_cm3.x” folder.
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<Project settings for the sample program>

Setting of e2 studio related to the sample program for making the initial settings of the microcomputers incorporating the 
R-IN engine is shown below. 

Note 1. Building the project for the Cortex-R4 automatically builds the project for the Cortex-M3..

Note 1. The data is copied from the Cortex-M3 and fetched into the section “.cm3” in the Cortex-R4 as the binary image.

Note 1. "_PowerON_Reset" is the entry point for each project. Replace it if the entry point is different.

Table. Settings in the Project for the Sample Program (Cortex-R4)

Project -> Properties -> Project References

Project references for ‘sample_cr4’*1 sample_cm3 Switch checkmark on

Table. Settings in the Project for the Sample Program (Cortex-M3)

Project -> Properties -> C/C++ Build -> Settings

Build Steps*1 Post-build steps Command: arm-none-eabi-objcopy -I elf32-littlearm -O binary sample _cm3.x cm3.bin & 
arm-none-eabi-objcopy -I binary -O elf32-littlearm -B arm --rename-section
.data=.cm3,alloc,data,readonly,load,contents cm3.bin cm3.o & copy /
Y cm3.o..¥..¥sample_cr4¥cm3.bin¥cm3.o

Table. Debug Configuration for the Sample Program

Run -> Debug Configurations

Debugger -> 
Connection Settings ->
Connection

Reset on connection “NO”

Reset before run [sample_cr4 HardwareDebug]:
“YES”

[sample_cm3 HardwareDebug], [sample_cm3 HardwareDebug 
Load modules]:
“NO”

Startup Runtime options [sample_cr4 HardwareDebug, sample_cm3 HardwareDebug]
Switch checkmark on the “Set break point at:” and set 
“_PowerON_Reset”. *1

Run commands [sample_cm3 HardwareDebug]
Set “set $pc=&_PowerON_Reset”.*1
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Website and Support
Renesas Electronics website

http://www.renesas.com/

Inquiries

http://www.renesas.com/inquiry
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Appendix-1. Supplementary Notes on Development Environments
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(7): The description modified. The figure modified.

45 (e2 studio from Renesas) <Steps up to debugging of the sample program (when booting is 
through the SPI)>
(8): The description added

45 (e2 studio from Renesas) <Steps up to debugging of the sample program (when booting is 
through the SPI)>
(9): The description modified. The figure deleted.

46 (e2 studio from Renesas) <Project settings for the sample program>
Table. Debug Configuration for the Sample Program: Note 1, added

1.30 Apr. 27, 2018 All "ARM" changed to "Arm"
2. Operating Environment

5 Table 2.1 Operating Environment: The description in the integrated development 
environments, modified; The version number of the integrated development environment 
from IAR Systems, modified; The description of “Devices (functions to be used on the 
board)”, modified

6. Software
9 6.1 Operation Overview: The error in step 3, corrected
10 Table 6.1 Settings of SW4: The names of the sample programs, modified
10 6.2.1 Section Assignment for the Sample Program: The error, corrected
10 Table 6.2 Sections to be Used (Cortex-R4): The description in Note 1 and Note 3, modified
11 Table 6.3 Sections to be Used (Cortex-M3): The HEAP line moved to below the readwrite 

line; The MAIN_STACK area, deleted
13 Figure 6.3 Assignment of Sections (Cortex-M3): The HEAP line moved to below the 

readwrite line; The MAIN_STACK area, deleted
16 Table 6.7 Global Variables: The function of type uint32_t, modified

7. Sample Program
29 The description, modified

8. Related Documents
30 The description, modified
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 Application Note: Initial Settings of the Microcomputers Incorporating the R-IN Engine

1.30 Apr. 27, 2018 Appendix-1. Supplementary Notes on Development Environments
31, 32 (EWARM from IAR systems): Images in steps (4) to (6) for debugging the sample program, 

modified
33 Table. Settings in the Project for the Sample Program (Cortex-R4): Debugger: The 

description in Debugger/Extra options/Synchronous, modified. Note 2, added.
36 (DS-5 from ARM): The description and image in step (7) for debugging the sample 

program, modified
45 Table. Settings in the Project for the Sample Program (Cortex-M3): Modified
45 Table. Debug Configuration for the Sample Program: The description in Startup/Run 

commands, modified
1.31 Jul. 13, 2018 — Revision with updating of the sample program

Rev. Date
Description

Page Summary

All trademarks and registered trademarks are the property of their respective owners.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. 

For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well 

as any technical updates that have been issued for the products.

1. Handling of Unused Pins
Handle unused pins in accordance with the directions given under Handling of Unused Pins in the 
manual.
⎯ The input pins of CMOS products are generally in the high-impedance state. In operation with an

unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an 
associated shoot-through current flows internally, and malfunctions occur due to the false 
recognition of the pin state as an input signal become possible. Unused pins should be handled as 
described under Handling of Unused Pins in the manual.

2. Processing at Power-on
The state of the product is undefined at the moment when power is supplied.
⎯ The states of internal circuits in the LSI are indeterminate and the states of register settings and 

pins are undefined at the moment when power is supplied.
In a finished product where the reset signal is applied to the external reset pin, the states of pins 
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at 
which resetting has been specified.

3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.
⎯ The reserved addresses are provided for the possible future expansion of functions. Do not access 

these addresses; the correct operation of LSI is not guaranteed if they are accessed.
4. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become stable. 
When switching the clock signal during program execution, wait until the target clock signal has 
stabilized.
⎯ When the clock signal is generated with an external resonator (or from an external oscillator) 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. 
Moreover, when switching to a clock signal produced with an external resonator (or by an external 
oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products
Before changing from one product to another, i.e. to a product with a different part number, confirm 
that the change will not lead to problems.
⎯ The characteristics of Microprocessing unit or Microcontroller unit products in the same group but 

having a different part number may differ in terms of the internal memory capacity, layout pattern, 
and other factors, which can affect the ranges of electrical characteristics, such as characteristic 
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a 
product with a different part number, implement a system-evaluation test for the given product.
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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for 

the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by 

you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or 

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application 

examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by 

you or third parties arising from such alteration, modification, copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the 

product’s quality grade, as indicated below.

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic 

equipment; industrial robots; etc.

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

 Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are 

not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause 

serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all 

liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or 

other Renesas Electronics document.

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the 

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation 

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified 

ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a 

certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury 

or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to 

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult 

and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and 

sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics 

products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable 

laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws 

or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or 

transactions.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third 

party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1)  “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note 2)  “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Notice
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